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OVERVIEW 

 

At the University of Pennsylvania, a PhD candidate presents and defends the dissertation publicly, and 

then, with the approval of the dissertation committee and graduate group chair, submits the final 

manuscript for publication to the Office of the Provost. The PhD degree is awarded to the candidate upon 

the recommendation of the Graduate Council of the Faculties. 

In preparation for the submission of a dissertation for publication, degree candidates should consult these 

guidelines early and often for assistance with the formatting of their manuscript. Other resources include 

Formatting Templates (Word and LaTeX versions are available), a Formatting Checklist, and Formatting 

FAQs. Formatting will likely take longer than anticipated, so please set yourself up for success by 

following the formatting guidelines for your own document early in the process or using the dissertation 

templates provided.  

Complete the PhD Dissertation Formatting Checklist to ensure you have followed all formatting 

requirements. Dissertations that do not comply with these guidelines will not be accepted and will require 

revisions before being approved. 

  

https://provost.upenn.edu/dissertation-templates
https://provost.upenn.edu/sites/default/files/users/user3179/PhD%20Candidate%20Formatting%20Checklist_0.pdf
https://provost.upenn.edu/formatting-faqs
https://provost.upenn.edu/formatting-faqs
https://provost.upenn.edu/sites/default/files/users/user3179/PhD%20Candidate%20Formatting%20Checklist_0.pdf
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FORMATTING FOR THE ENTIRE DOCUMENT 

File Type 
Final dissertations must be uploaded to ETD Administrator in PDF format. After converting to PDF, please 

review the entire document to make sure that all sections and formatting converted properly, especially 

images and graphs which may have been affected by the conversion. 

Organization of pages 
Pages must appear in the following order 

1. Preliminary Pages: This is the front matter of your dissertation. The Title Page and Copyright 

Notice do not have page numbers. All other pages in this section use lowercase Roman numerals 

for page numbers (ii, iii, iv). Do not add sections that are not listed below; additional sections may 

be included as Appendices. 

A. Title Page (required; no page number but is counted as page i) 

B. Copyright Notice (optional; no page number, but counted as page ii, if included) 

C. Dedication (optional) 

D. Acknowledgment (optional) 

E. Abstract (required) 

F. Table of Contents (required) 

G. List of Tables (required if the main text includes tables) 

H. List of Illustrations (required if the main text includes illustrations, figures, photos, maps, 

schemes, or pictures) 

I. Preface (optional) 

2. Main Text: (required) This is the body of your work beginning on page 1. This section uses 

Arabic numerals for page numbers (1, 2, 3). 

a. Chapters must have a title and a number (example: CHAPTER 1: TITLE OF CHAPTER) 

and must be listed in the Table of Contents. 

b. The main text section may include Footnotes or Endnotes.  

3. Appendices (optional)  
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4. Bibliography (required) 

5. Index: An index is optional for most graduate groups, but it is required for the following graduate 

groups:  

• Architecture 

• City & Regional Planning 

• Earth & Environmental Science 

• East Asian Languages & Civilization 

• Near Eastern Languages & Civilization 

Margins 
 
IMPORTANT: Absolutely nothing may be in the blank margin space. Page numbers, footnotes, 

headers, and any part of any tables, figures, schemes, and text must all be kept out of the margin space.  

Margins on every page of the dissertation must be 1 inch on each side (updated December 2022).  

• left margin: 1 inch  

• right margin: 1 inch  

• top margin: 1 inch 

• bottom margin: 1 inch  

Do not use a running head (printing the page title on every single page) in your dissertation.  

Microsoft Word Tip: You may view your margins in Word by using the rulers at the top and side of 

the document. You may also enable Show text boundaries to see if any of your text, images, or frames 

land outside of the margins by following these steps: 

1. Click on the File menu   

2. At the bottom of the left-hand menu, click Options 

3. On the left-hand menu, click on the Advanced tab 

4. Under the heading Show document content, select Show text boundaries 
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Illustration  1: Show text boundaries 

 

Illustration  2: Examples of images inside and outside the text boundaries 
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Fonts 
 

A font 10-12 points in size and a consistent color (black) should be used. We recommend Arial (10pt), 

Calibri (11pt), Georgia (11pt), or Times New Roman (12 pt).  

For footnotes, figures, citations, charts and graphs, a font of 8 points or larger should be used. Italic type 

may be used for quotations, words in a foreign language, occasional emphasis, book titles, or to 

differentiate subheadings. 

When converting your document to PDF, the fonts must be embedded. ProQuest ETD Administrator has 

a how-to guide for embedding fonts using Microsoft Word on a PC or Mac. 

Headings and Subheadings 

Preliminary pages and chapters must include headings in ALL CAPITAL LETTERS (example: CHAPTER 

1: TITLE). Headings may be larger than the main text but should not exceed 36 point font nor should 

there be excessive spacing. Headings should be a consistent font color (black) to match the rest of the 

text. You may choose to include subheadings for sections within a chapter; subheadings may be italicized 

or bolded and are not required to be in all capital letters.  

Microsoft Word Tip: By using the Styles menu in Word, you can designate different levels of 

headings to correspond to the chapter headings and subheadings in your dissertation. If you designate 

chapter headings as “Heading 1” and chapter subheadings as “Heading 2,” then your table of contents 

can be accurately and quickly generated using the References tab. See Appendix B.  

Spacing 
 
We recommend double-spacing the text of your dissertation, including the preliminary pages and the 

Bibliography. Only the following parts of your text are required to be single-spaced: 

• Footnotes 

• Long quoted passages (more than four lines of prose or three lines of verse) 

https://support.proquest.com/articledetail?id=kA01W000000k9hkSAA
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Text Alignment 

Your main text must be either left-aligned or justified. 

You may choose to indent new paragraphs or sections, but it is not required.  

Pagination 
 

• The Title page DOES NOT have a page number, but for counting purposes, it is considered page 

i. 

• The optional Copyright notice DOES NOT have a page number, but for counting purposes, it is 

considered page ii. 

• The preliminary pages are numbered with lowercase Roman numerals (ii, iii, iv…) from the 

optional Dedication page through the end of the optional Preface. 

• The main text is numbered with Arabic numerals (1, 2, 3) from the first page of Chapter 1 to the 

end of the Bibliography or optional Index. 

• In Word, the best way to manage the transition from using roman numeral page numbers for the 

preliminary pages and Arabic numerals for the main text is to use a section break. For more 

information on section breaks, visit Microsoft Office Support.  

• Page numbers cannot appear in the blank margin space. 

• Page numbers are recommended to be at the bottom of your page, but you may also choose to 

put them at the top. Whether they are at the bottom or the top of the page, there must still be 1 

inch of blank margin space between the page number and the edge of the page.  

Microsoft Word Tip: In Word, this can be adjusted when you click the page number in the footer. 

The Header & Footer menu will show at the top; in the Position section, increase the Header from Top 

or Footer from Bottom distance to 1 inch.    

https://support.microsoft.com/en-us/office/insert-a-section-break-eef20fd8-e38c-4ba6-a027-e503bdf8375c
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Illustration  3: Adjusting Footer from Bottom to 1 inch 

Landscape Pages 
 

Landscape oriented images and tables are allowed, but they must be formatted as they would be in a 

book: i.e., they are rotated counterclockwise 90 degrees and bound along the top. Landscape pages must 

also have 1 inch margins on all sides. The page number will be on the left side of the page (instead of the 

bottom), and the number will be horizontal.  

The easiest way to format your landscape page is to rotate your image and its caption so that the page 

remains in portrait orientation, but the top of the image is to the left and the bottom of the image is to the 

right. 

View a sample of a properly formatted landscape page. 

 

TITLE PAGE 

 

The title page is required. View a sample title page here.  

• The title page is understood to be page “i” for counting purposes, but no page number should 

be printed on the title page. 

• The title of your dissertation must be centered one inch from the top of the page in all 

UPPERCASE letters. If the title is more than one line, it must be double-spaced.  

https://provost.upenn.edu/sites/default/files/users/user125/A%20Sample%20Landscape%20Page.pdf
https://provost.upenn.edu/sample-dissertation-title-page
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• Your name on your title page must match your name on your student record in Path@Penn. If 

you want to use a name that differs from the name in Path@Penn, please provide the necessary 

documentation with the Student Data Change Form to the Office of the University Registrar. 

• The official graduate group name is very specific and must match the name as listed in the 

Official Names of Graduate Groups. 

• Students in Romance Languages or Managerial Science and Applied Economics (Wharton) must 

also include their field of specialization above the graduate group name. These students should 

view the sample Romance Languages and Wharton Title Pages. 

• The year must be the current year of your deposit. 

• Signatures on the title page are optional. Unsigned title pages are accepted. If a candidate 

chooses to include signatures, the dissertation supervisor(s) and the graduate group chair must 

all sign.    

• All committee member names must be included on the title page. Do not omit any committee 

members.  

• The full faculty title will include the professor’s rank and department, if they hold a named 

professorship, and, for any external committee members, their affiliation. You do not need to list 

any Penn schools (for example: Perelman School of Medicine) on the title page.  

• All faculty names on the title page must be formatted consistently. For example, if you include 

PhD or MD for one faculty member, include them for all.  

COPYRIGHT NOTICE  

 

The copyright page is optional. The United States does not require you to include a copyright notice or 

formally register to have copyright protections over your work. See the Dissertation Copyright guidelines 

for more information and to schedule a copyright consultation.  

• If you do include a copyright page: 

o Do not put a page number on the copyright page. It is understood to be page “ii.”  

https://path.at.upenn.edu/
https://path.at.upenn.edu/
https://srfs.upenn.edu/student-records/update-data
https://provost.upenn.edu/phd-graduate-groups
https://provost.upenn.edu/sample-dissertation-title-page
https://guides.library.upenn.edu/copyright/registration
https://provost.upenn.edu/dissertation-copyright
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o The page numbers should start appearing on the page after the copyright page and will 

start with “iii”. 

• If you do not include a copyright page, numbering starts on the page after the title page, page ii. 

The copyright page consists of 4-5 lines: 

1. The first line of the copyright page is the full title of your dissertation in ALL UPPERCASE letters.  

2. The second line is the word COPYRIGHT in all capital letters. Do not include the symbol ©. 

3. The third line is the current year.  

4. The fourth line should be your full, legal name with full middle name, and in normal capitalization 

(e.g., Jane Jean Doe).  

5. You may optionally include a Creative Commons note (see below). 

Creative Commons Note 

You may choose to use a Creative Commons License, which allows you to tell others certain ways in 

which they may reuse your work without first asking permission from you (note that you still retain 

copyright, some rights reserved). This is optional. If using, go to https://creativecommons.org/choose to 

choose a license and add the appropriate information in the template.  

DEDICATION 

 

The dedication page is optional.  

• It uses a small Roman numeral page number (ii, iii…). 

• The dedication page does not use a heading  

• The dedication page does not appear in the Table of Contents.  

• The dedication text must be in italics.  

ACKNOWLEDGMENT 

 

The acknowledgment page is optional.  

• It uses a small Roman numeral page number (ii, iii, iv…). 

https://creativecommons.org/choose/
https://creativecommons.org/choose/


10 
 

• The acknowledgment page header (“ACKNOWLEDGMENT” or “ACKNOWLEDGMENTS” must 

be in ALL UPPERCASE LETTERS.  

• The acknowledgment page must be listed in the Table of Contents.  

ABSTRACT 

 

The abstract page is required. The abstract will be published online by ProQuest in Dissertation 

Abstracts International and on ScholarlyCommons (Penn’s institutional repository), providing information 

to interested readers about the general content of the dissertation. Please pay close attention to the 

required content, as this page is a common source of errors.  

• This page uses a small Roman numeral page number (ii, iii, iv…).  

• The abstract is a condensed summary of the dissertation, not to exceed 350 words.  

• All words, including the title and names, count toward the 350-word total.  

• The abstract page is double-spaced.  

• The abstract page must be listed in the Table of Contents. 

• The abstract, which is normally a single paragraph, consists of four parts: the statement of the 

problem; the procedure and methods used to investigate the problem; the results of the 

investigation; and the conclusions.  

• The dissertation title must match the title on your optional copyright notice and required title page. 

• The dissertation author’s name must match the name on your student record and title page.  

 

At the top of the page will be these 4-5 lines of text: 

1. The first line is the word "ABSTRACT" in ALL UPPERCASE letters. 

2. The next line is the TITLE of the dissertation in ALL UPPERCASE letters. 

3. The next line is the author’s (your) name in normal capitalization (e.g., Jane J. Doe). It must 

match your name as it appears in Path@Penn.  

https://about.proquest.com/en/dissertations/
https://about.proquest.com/en/dissertations/
https://repository.upenn.edu/edissertations/
https://path.at.upenn.edu/
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4. The next line is your dissertation supervisor's name with normal capitalization. Do not include any 

titles as this is indicated by the placement of the names (for example, do not include Professor, 

Co-Supervisor, Dr., or Ph.D.). 

5. Only if you have a co-supervisor: on the next line after the supervisor’s name is the co-

supervisor’s name with normal capitalization and no titles (for example, do not include Professor, 

Co-Supervisor, Dr., or Ph.D.).  

Example: 

 

ABSTRACT 

DISSERTATION TITLE IN ALL UPPERCASE LETTERS 

Caroline Gonzalez Ciccone 

Benjamin Franklin 

Thomas Jefferson 

 

The abstract text uses my remaining 337 words, since there are 13 words in the names 

and title. Here I would have a condensed summary of all my research, including the 

statement of the problem; the procedure and methods used to investigate the problem; 

the results of the investigation; and the conclusions.   
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TABLE OF CONTENTS 

 

• It uses small roman numeral page numbers (iii, iv…).  

• The table of contents page is required.  

• The heading must be “TABLE OF CONTENTS” in ALL UPPERCASE LETTERS. 

 

The table of contents must include the following: 

• Acknowledgment (if included in your dissertation) 

• Abstract (required) 

• List of Tables (required if the main text includes tables) 

• List of Illustrations or List of Figures (required if the main text includes illustrations, figures, 

photos, maps, schemes, or pictures) 

• Preface (optional) 

• All Chapters (example: CHAPTER 1: TITLE OF CHAPTER, etc.) 

o Subsections – if your text contains subsections, it is recommended to include them in the 

Table of Contents. They should be included in a consistent format.  

• Appendices (if included in your dissertation) 

o Each Appendix must be listed. For example: 

APPENDIX A: TITLE OF APPENDIX 

APPENDIX B: TITLE OF APPENDIX 

• Bibliography 

Microsoft Word Tip: Word allows you to automatically generate a table of contents. By using the 

Styles menu in Word, you can designate different levels of headings to correspond to the chapter 

headings and subheadings in your dissertation. If you designate chapter headings as “Heading 1” and 

chapter subheadings as “Heading 2,” then your table of contents can be accurately and quickly generated 

using the References tab.  
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You may choose to have your Table of Contents be hyperlinked to sections within your document, but if 

you include hyperlinks, they must be consistent (included for all sections and in a consistent format). 

 

Illustration  4: Selecting Heading 2 in the Styles menu 

To generate a Table of Contents: 

1. Open the References tab from the top menu in Word 

2. Select the Table of Contents drop-down menu 

3. Select a table of contents style 
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4. Whenever you add chapters or subchapters, you can click on your Table of Contents and select 

Update Field and Update Entire Table which will automatically update the listings and page 

numbers.  

5. For more information on how to automatically generate a table of contents in Word, please see: 

https://support.microsoft.com/en-us/office/insert-a-table-of-contents-882e8564-0edb-435e-84b5-

1d8552ccf0c0.  

 

Illustration  5: Adding a Table of Contents from the References tab 

https://support.microsoft.com/en-us/office/insert-a-table-of-contents-882e8564-0edb-435e-84b5-1d8552ccf0c0
https://support.microsoft.com/en-us/office/insert-a-table-of-contents-882e8564-0edb-435e-84b5-1d8552ccf0c0
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Illustration  6: Right click and select Update Field to automatically update the Table of Contents 

LIST OF TABLES 

 

The List of Tables is required if your document has tables in the text. 

• This page has a small roman numeral page number because it is a preliminary page (ii, iii, iv) 

• It should be titled LIST OF TABLES in ALL UPPERCASE LETTERS. 

• The List of Tables is meant to help readers navigate to the location of each table in the 

manuscript; thus, it is formatted like a table of contents with page numbers for each table.  

• Make sure all tables are labeled with a number and title. Numbering must be consecutive and 

match your chosen citation style (e.g., MLA, APA, Chicago). 
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• The list itself may be single or double-spaced.  

• The List of Tables must be included in the Table of Contents. 

• Tables in the appendices do not need to be included in the List of Tables. 

Microsoft Word Tip: This list can also be automatically generated in Microsoft Word, if you use the 

References menu to format your table captions. For more information on how to do this, please see this 

short tutorial: https://www.youtube.com/watch?v=z6NP31Q1w3M.  

 

Illustration  7: Inserting a Table caption using the References tab 

 

Once you have captions, you can insert your list using the References tab to select Insert Table of 

Figures.  

https://www.youtube.com/watch?v=z6NP31Q1w3M
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Illustration  8: Using the Table of Figures function in the References tab to make a List of Tables 

LIST OF ILLUSTRATIONS OR LIST OF FIGURES 

 

The List of Illustrations or List of Figures is required if your document has illustrations, photos, pictures, 

figures, maps, or schemes in the text. It goes after the List of Tables if you have one, or after the Table of 

Contents if there is no list of Tables. 

• This page uses a small roman numeral page number (iv, v, vi…) because it is a preliminary page.  
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• It must be titled LIST OF ILLUSTRATIONS or LIST OF FIGURES in ALL UPPERCASE 

LETTERS. 

• The List of Illustrations or List of Figures is meant to help readers navigate to the location of each 

illustration or figure in the manuscript; thus, it is formatted like a table of contents with page 

numbers for each illustration or figure.  

• Make sure all illustrations and figures are labeled with a number and title. Numbering must be 

consecutive and match your chosen citation style (e.g., MLA, APA, Chicago). 

• The list itself may be double-spaced or single-spaced (suggested for long lists).  

• The List of Illustrations or List of Figures must be included in the Table of Contents. 

• Illustrations/figures in the appendices do not need to be included in the List of Illustrations or List 

of Figures. 

Microsoft Word Tip: This list can also be automatically generated in Microsoft Word if you use the 

References menu to format your illustration captions. For more information on how to do this, please see 

the section on List of Tables above or this tutorial: https://www.youtube.com/watch?v=z6NP31Q1w3M 

OTHER LISTS 

If required by your field, you may choose to include an optional List of Abbreviations or List of Translated 

Words. These lists should be included in the Appendix and should be identified with an appropriate 

heading and formatted similar to the other lists. 

PREFACE 

 

Including a Preface is optional.  

• If you choose to include a Preface, it uses small roman numeral page numbers as it part of the 

preliminary pages. 

• It must be called “PREFACE” in ALL UPPERCASE letters.  

https://www.youtube.com/watch?v=z6NP31Q1w3M
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• The Preface must be included in the Table of Contents.  

• Introductions are not part of the preliminary pages and are considered part of the main text, so 

should start at page 1.  

MAIN TEXT OF THE DISSERTATION 

 

• The main body of your dissertation begins with page 1, which will either be an Introduction or 

Chapter 1. 

• From this point on, your pages will have Arabic numerals (1, 2, 3…). 

• All chapters must be numbered.  

• You must include the chapter number and chapter title on the first page of each chapter in ALL 

UPPERCASE LETTERS. 

• Chapters titles and headings should be formatted in a consistent heading style so that they 

appear on your Table of Contents.  

• The font and size of the text should be uniform all the way through.  

CHAPTER 2 

AN EXAMPLE OF A CHAPTER TITLE 

An example of a subheading 

An example of normal text in the chapter. 

 

USING PREVIOUSLY PUBLISHED ARTICLES 

University of Pennsylvania policy allows you to include your own previously published work or articles 

submitted for publication as part of the dissertation with the following conditions: 

• You must obtain approval of the dissertation committee and Graduate Group Chairperson. 

https://catalog.upenn.edu/pennbook/academic-rules-phd/
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• You must obtain written permission from the copyright owner, which may be the journal, 

publisher, and/or any co-authors, unless you are the sole copyright holder (depends on your 

publishing agreement).  

• You must upload any permission letters in ETD Administrator as a supplemental file titled 

“Permission Letter – Do Not Publish.” 

• For dissertations based on joint work with other researchers, a unique and separate dissertation 

must be presented by each degree candidate. You must include a concise account of your unique 

contribution to the joint work, and remainder of the dissertation must be authored solely by you. 

Authorship of an entire dissertation by more than one degree candidate is not allowed. 

• Your dissertation must be formatted as a single document with consistent formatting and styles 

throughout. If you are using multiple previously published articles, make sure to make the 

formatting consistent with the rest of the document. 

When using previously published or in press work, you must disclose this information in your 

dissertation in the following format:  

• Under the Chapter title, list the full citation for the previously published/in-press article in the 

citation style used in your Bibliography.  

• If it is a jointly authored article, describe your contribution to the work in a separate sentence. 

EXAMPLE: 

CHAPTER 3 

TITLE OF CHAPTER 

This chapter was previously published/is in press as [insert full citation in your citation format: Author 

Name(s). Title of Article. Journal. Year. Link if any]. For jointly authored articles, include a description of 

your contribution to the work. 

Start of Chapter text.  



21 
 

 

FOOTNOTES OR ENDNOTES 

 

Notes can appear as footnotes below the text on a page, or as endnotes at the end of each chapter. You 

must choose to use either footnotes or endnotes throughout your dissertation. You cannot vary 

between footnotes and endnotes in different chapters.  

• Footnotes and endnotes must be single-spaced.  

• Footnotes at the bottom of a page must be numbered continuously throughout the dissertation. 

The count must not restart with each chapter. For example, if Chapter 1 has 20 footnotes then the 

footnotes for Chapter 2 should start at 21.  

• A bottom-of-the-page footnote must begin on the same page as the text to which it refers, but it 

may continue on the following page if necessary.  

• Footnotes may never go in the blank margin space. 

• Endnotes at the end of a chapter are numbered separately for each chapter (i.e., the first note of 

each chapter will always be numbered “1”).  

APPENDICES 

Appendices are optional. 

• All Appendices must be labeled with a capital letter. Example: 

APPENDIX A: TITLE OF APPENDIX A 

APPENDIX B: TITLE OF APPENDIX B 

• If you have Appendices for each chapter, they must still go at the end of the main text. You can 

indicate that they refer to a particular chapter in the Appendix title; for example:  

APPENDIX A: SUPPLEMENTAL MATERIAL FOR CHAPTER 4 

APPENDIX B: SUPPLEMENTAL MATERIAL FOR CHAPTER 5 

• You must list all Appendices in the Table of Contents.  
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• Tables and Figures in the appendices must be labeled, but do not need to be included in the List 

of Tables or List of Illustrations. 

 

BIBLIOGRAPHY 

 

The Bibliography is required.  

• The Bibliography is an alphabetical listing of all references or a numbered reference list, 

depending on the citation style for your field.  

• If your list is numbered, the entries must be in order of use. 

• Page numbers in the bibliography continue the pagination of the main text; do not number the 

bibliography separately.  

• The Bibliography should be double spaced, but you may choose to single space the text.  

• You may include end-of-chapter bibliographies instead of an end-of-work bibliography if that is 

the standard formatting for your field. 
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APPENDIX A: OFFICIAL NAMES OF GRADUATE GROUPS 

The title page must show the formal version of the graduate group name. Do not add the words 

“Graduate Group in” or “Department of.” Only use the name as pictured below. This list was last updated 

on November 22, 2022. A list of Graduate Group names is also available at 

https://provost.upenn.edu/phd-graduate-groups.  

Africana Studies 
Ancient History 
Anthropology 
Applied Mathematics and Computational Science 
Architecture 
Art and Archaeology of the Mediterranean World 
Biochemistry and Molecular Biophysics 
Bioengineering 
Biology 
Cell and Molecular Biology 
Chemical and Biomolecular Engineering 
Chemistry 
City and Regional Planning 
Classical Studies 
Communication 
Comparative Literature and Literary Theory 
Computer and Information Science 
Criminology 
Demography 
Earth and Environmental Science 
East Asian Languages and Civilizations 
Economics 
Education 
Electrical and Systems Engineering 
English 
Epidemiology and Biostatistics 
Genomics and Computational Biology 
Germanic Languages and Literatures 
History of Art 
History 
History and Sociology of Science 
Immunology 
Linguistics 
Managerial Science and Applied Economics 
      Accounting 
      Applied Economics 
      Ethics and Legal Studies 
      Finance 
      Health Care Management & Economics 
      Management 
      Marketing 
      Operations, Information and Decisions 
      Statistics and Data Science 

https://provost.upenn.edu/phd-graduate-groups
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Materials Science and Engineering 
Mathematics 
Mechanical Engineering and Applied Mechanics 
Music 
Near Eastern Languages and Civilizations 
Neuroscience 
Nursing 
Pharmacology 
Philosophy 
Physics and Astronomy 
Political Science 
Psychology 
Religious Studies 
Russian and Eastern European Studies 
Romance Languages 

French and Francophone Studies 
Hispanic Studies 
Italian Studies 

Sociology 
Social Welfare 
South Asia Regional Studies 
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APPENDIX B: USING HEADING STYLES  

 

This guide uses- and we recommend that you use- an automatically generated Table of Contents. By 

formatting chapters and chapter titles as “Heading 1” and subheadings as “Heading 2” under the Styles 

menu located in the Home tab in Word, your table of contents can be accurately and quickly generated 

and updated. 

To format a chapter title, just select the text and click the Heading 1 button on the Home menu seen in 

the illustration below. 

To change the font size and color of a Heading Style, format the chapter title as you want it to appear, 

then highlight the chapter title. In the Styles menu, right click Heading 1 and select Update Heading 1 to 

Match Selection. This will automatically format all text that is marked as Heading 1. You can use the 

same process to format subheadings using Heading 2. 

Illustration 3.  

Screenshot Of Styles Menu on Home Screen with Heading 1 Selected 

 


